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1 Introduccion

En este manual se describe la funcionalidad de la aplicacién KeyTool Ul versién 2.4.

2 Conceptos basicos

KeyTool IUl es una aplicacién dotada de un interfaz grafico de uso muy sencillo, que pretende ayudar en
la realizacion de tareas criptogréaficas enmarcadas en el entorno de las aplicaciones Java.

El JDK de Sun, incluye algunas herramientas de manejo de claves y del almacén de certificados (keytool,
jarsigner), pero su ejecucion es desde linea de comandos, no se incluyen herramientas visuales que faciliten el
trabajo con certificados. KeyTool IUl pretende dar al menos la misma funcionalidad que las herramientas de Sun
pero con un interfaz grafico muy sencillo. Ademas proporciona otra funcionalidad como la de cifrado de ficheros

Con KeyTool Ul se podra crear un nuevo almacén de claves (KeyStore), importar en él certificados,
firmar ficheros con dichos certificados, etc.

En el momento de escribir este documento la ultima version disponible de la aplicacion es la 2.4.
Puede encontrarse informacion adicional en inglés sobre el producto, en la pagina web:

http://yellowcat1.free.fr/index ktl.html

o en francés, en:

http://ragingcat.developpez.com/java/outils/keytool/ui/

3 Integracion con la implementacion Java

La aplicacion KeyTool IUl es una herramienta desarrollada en Java y como tal utiliza por defecto el
almaceén de certificados que viene con la implementacion Java con la que se arranca la aplicaciéon. Puede verse
accediendo al menu: “Help = About = KeyTool IUL...”, en la pestafia ‘Advanced’ se indica el almacén de
certificados que utiliza el sistema por defecto:
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& About KeyTool TUT B |
General [ Advanced |
Launcher:
Eclipse plugin

MetBeans IDE module
Java Wveh Start
W standalone application

Properties:

Application's cache dir: [C:\Ducuments and Settingsladmintrecp

User name: [admin

Certificate stores:

Systern-level root CA |CAProgramastdavay2EEsdkjdijrallimsecuribicacernts

CLOSE

3.1 Conceptos basicos de Criptografia y Java

En Java existen dos APIs utilizadas fundamentalmente para temas criptograficos, son: JCE (Java
Criptography Extension) y JSSE (Java Security Socket Layer).

JCE es un API que da soporte para la realizacion de servicios criptograficos como: implementacion de
algoritmos de cifrado (RSA, DSA, AES, Triple DES, SHA, PKCS#5, etc.), cifrado de textos (simétrico, asimétrico,
de bloque, etc...), firmas digitales, generacion de claves y certificados, etc.

JSSE se utiliza fundamentalmente para comunicaciones seguras, dando soporte a protocolos como SSL,
TLS, Kerberos (utilizando GSS-API). Ofrece una completa implementacion de HTTPS sobre TLS y SSL.

Ambas APIs utilizan los almacenes de claves y certificados (Keystores), que son ficheros que almacenan
de forma segura los certificados de las entidades certificadores, los pares de clave publica y privada de un
usuario y cualquier otra clave privada utilizada para cifrar un texto.

El almacén que utiliza Java por defecto es el que se encuentra en el directorio lib\security\ de la
implementacion JRE utilizada, y se llama cacerts, pero puede cambiarse, bien en el arranque de la aplicacion,
bien por programa.

Cuando en el presente manual se hace referencia a una clave privada, se esta haciendo referencia al

conjunto de clave privada — clave publica utilizado en el cifrado asimétrico. Cuando se hace referencia a una
clave secreta, se esta haciendo referencia a la utilizada en el cifrado simétrico.
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Con la aplicacién KeyTool IUl se pueden ver todos los certificados de las autoridades certificadoras (CAs)
y claves (publica y privada) que incluya un almacén.

4.1 Formatos admitidos para certificados y claves

Los formatos que admite la aplicacién para almacén de claves y certificados son:

Extension
Formato Nombre del Fichero
JKS Java Keystore o Tipo de formato ideado Jjks
inicialmente para el Java de Sun ks
JCEKS Java Cryptography Extension Definido en el API JCE jce
Keystore
Public Key Cryptography p12
PKCS12 Standards #12 .pfx
BKS Bouncycastle Keystore Definido por el grupo .bks
BouncyCastle
Version méas segura definida por
UBER Bouncycastle UBER Keystore el grupo BouncyCastle .ubr

También pueden visualizarse los certificados guardados en ficheros. Los formatos de fichero aceptados

por la aplicacion son:

Extension
Formato Nombre del Fichero
DER Codificaciéon DER: Definido en el estandar X.690 de .crt
Distinguished Encoding Rules ITU-T cer
. Derivado de la sintaxis definida
CMS Cryptographic Message Syntax en PKCS#7 .p7c
e . o También llamada: “printable
PEM Codificacion PEM: Prwa_cy- PKCS#7”, por generar un fichero .pem
Enhanced Electronic Mail ASCI|
. Estandar para la solicitud de
PKCS10 Public Key Cryptography certificacion de una clave -p10
Standards #10 e .csr
publica a una CA.
, Utilizado en las respuestas de
PKCS7 g?abr:ga}r(;g #C7r yptography las CAs a una solicitud de .p7b
certificacién (PKCS#10).
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4.2 Visualizacion de certificados y claves en un almacén

Para ver los certificados y claves en un almacén, acceder al menu: “View - File > Keystore” y
seleccionar la opcion deseada en funcion del formato del almacén.

B xeyTool 1UI

File | ¥iew | Tools Help

Selecttask | B Ihm

File b | Keystore b A8 JKS keystore . N
Certificate »| 8 JCEKS keystare .
O EC M PKCE12 keystore . -
M BKS keystore i
D Secret key i
o £ Archive files & UBER keystore .
[ Directory Systern-level root CA certificate store ..
ol o LT Y B T HO A N S B T T

Se puede acceder también desde el botén de la barra de herramientas:

Se mostrara un cuadro de didlogo para seleccionar el almacén:

& KeyTool 1UI - select X

Buscar en; ||j FPruebaskeyTool |V| E
D EuroHelpks.jce

Mombre de archivo: |EurnHeIpKS.jce |

Archivos de tipo: |JCEKS keystores (joed |V|

zelect || Cancelar |

Aparecera la siguiente ventana, con todos los certificados y claves que contiene el almacén.
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x|
Private Key (keypair) & Trusted Certificate Entries:

Alias Entry | Walid Date 7 | Seit-Signed 7 | Trusted C.A. 7 | KeySize | Cert Type | Cert Sig. Algo. | Modified Date
bbvacert 2 - 1023 hits  [%.508 SHATwIthRSA  |16-jul-200%
surohelpcent ] v 1024 hits  [+.508 MOEwithRSA 15-jul-200%
eurohelpclavel @ v ¥ - 2043 hits  [%.508 SHATwWithRSA  [15-jul-200%
verisigneert < < vy 2048 hits  [.509 SHATwithRSA  [16-jul-2008

Secret Key (shared key) Entries:
Alias | Entry Modified Date
eurohelpclaved | o |15-jul-2008

Visualizacion del detalle de un certificado o clave

contextual con el que se puede obtener mas informacion sobre dicha entrada.

Private Key (keypair) & Trusted Certificate En

Alias Entry | Yalid Date ?
hhvacert o
eurohelpcert i
aurohelpclave? [ o
verisighcert [ £

Wiew certificate ...

Se muestra en modo texto los datos del certificado o clave.

Pinchando con el botén derecho del ratdn sobre una entrada (certificado o clave), aparecera un menu
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& KeyTool IUI - view %.509 certificate |
Chirier=
Ch=VeriSign Class 2 Public Primary Cerdification Authority - G3, OU="{c) 1999 VeriSign, Inc. - For authorized u
l==uer=
Ch=YeriSign Class 3 Public Primary Certification Autharity - G3, OL="(c) 1999 VeriSign, Inc. - For authorized u
YWersion=1
Serial Mumber=9BTEOG49A33E62EADSEEQN4871 29EF ST
Walid From=viernes 1 de octubre de 1998 2:00
Yalid Until=juewves 17 de julio de 2036 1:59
Signature Algarithm=5HATwith R SA
Fingerprints=
mMDa  COESEBEAT.CT.CHCETIENID4F AT 44:.61:92:09
SHAT: 132000 45534B69:97.COELDSCI3EXA5TEENAB.5C.CH
Key Lsage= none
Extended Key Usage= none
1] Il I
CLOSE

4.3 Visualizacion del almacén por defecto de la implementacion Java

En el almacén de certificados que viene por defecto con el JRE de Java (cacerts), se incluyen varias CAs
en las que se confia. Si se desea ver cuales son, la aplicacién KeyTool IUl facilita el proceso, ya que dispone de
un menu de acceso directo a dicho almacén (ver la siguiente imagen).

& xeyTool TUT

File [Miew | Tools Help

Selecttask ¥ | [E lha
File b | Eeystare B

JKS keystare .

&b,
Ej\ 2 Certificate » * JCEKS keystore .
— 8 PRCS12 keystore
[ welcome 8 BKS kevstore <
¢ [ Create 8 UBER keystore . ]

[ Keystore

o [ Keystore's entry Systern-level root CA cerificate stare .
A T Dt L itk wnee W enot | |I |
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{_‘, KeyTool IUI - view JKS keystore ) 5[

Private Key (keypair) & Trusted Certificate Entries:

Alias Entry | Valid Date 7 | Selt-Signed 7 | Trusted CA. 7| Key Size | Cer Type | Ced. Sig. Algo. Modifled Date
addirustclassica 2048 bits  [X.504 SHATwithRSA 02-may- 2006 -
addirustexternalca 2048 hits  [}.509 SHATwithRSA 02-may-2006 3
addirustgualifiedca 2048 bits  [X.504 SHATwithRSA 02-may- 2006 T

2048 hits X509 SHATwithRSA  [17-ene-2008
2043 hits X609 SHATwithRSA  [10-may-2002
2043 hits X609 SHATwithRSA  [10-may-2002
1023 hits X609 SHATwithRSA  [16-jul-2008

2043 hits X609 SHATwithRSA  |D2-may-2006

anlrootcal
baltimarecadesignin...
baltimarecybertrustca
bbvacerichain
comodoaaaca

NN NSNS
e lae e fafa e e

IEEEEEEEEEERIE

SN SIS SIS S S

digicertassuredidroot... 2048 hits  [#.508 SHATwithRSA 07-ene-2008
digicertalobalrootca 2048 hits  [#.508 SHATwithRSA 07-ene-2008
digicerthighassuranc... 2048 hits  [#.508 SHATwithRSA 07-ene-2008 —
antrnctINAOrD 042 hit A00 CHATwWithP oA NQ.ono. 30072 x
Secret Key (shared key) Entries:

Alias Entry lodified Date

4.4 Visualizacion de certificados almacenados en fichero

La aplicacion dispone también de un menu para permitir la visualizacion de certificados almacenados en
ficheros. Para ello, acceder al menu: “View - File - Certificate” y seleccionar la opcion deseada en funcion del
formato del fichero.

& KeyTool IUI
Eile | ¥iews| Tools Help

Select task ¥
File k| keystare B

ﬂ By | Cerificate ¥ DER X509 (hinaryd cedificate ..
T T PECEHRT X509 (hinand cedificate ...
[4 welcome PEM ¥ 509 (ascil) certificate . r
9 [ Create
EI Keystare PECE®#1 0 (asciiy CER ..
e S RE N

Se mostrara la ventana para seleccionar el fichero:
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Buscaren: | PruebaskeyToal b

o-o-
o-o-

[} bbvaCertpTh

[ certificateFile.pTh
[ entidadayto.p7h
[ eurohelpeert.p?h
|j| signatureFile.p7h

Mombre de archivo: |en1idadﬁ3-1|:u.p.‘r‘h

Archivos de tipo: |F'I<CS#T cert. (pTh

|v|

zelect ‘ | Cancelar |

Una vez seleccionado el fichero con el certificado o cadena de certificados, se muestra en modo texto la

informacion:

{"_"J KeyTool IUI - view X.509 certificates chain

mHumber of cerificates in cedificates chain=3

-—-- BEGIM %5609 CERTIFICATE #173----
Chwner=

lsguer=

YWersion=3
Serial Mumber=2CFCEFEBE0001 00000091
Yalid From=jueves 20 de julio de 2006 12:43
Walid Until=rmigércoles 9 de julio de 2008 12043
Signature Algorithrm=SHATwith R SA
Fingerprints=
mMDa:  1A4B:08 45481 89802 FB:07:595:66:52:.E5.86:E5:FD

key Usange= not critical
List:
CdigitalSignature
-nonRepudation
. dataEncipherment

Dol o Lefme | e seim— ot critical

EMAILADDRESS=sloras@@aragon.es, CH=EMNTIDAD AYLUINTAMIENTD - CIF 87E5432

Ch=CA-1 UCGA L=Zaragoza, ST=Laragoza, OlU=Unidad de Ceificacion, O=Gaohierr |

SHAT TCIE3EAZALDETECE1E 49 9CAF 54 B2EETF.BEB3A3FO G4

[4]

< I |

L]

CLOSE
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5 Gestion de los almacenes de certificados y claves

Ademas de visualizar el contenido de los almacenes de certificados, la aplicacion KeyTool Ul permite
desde otra opcion de menu, gestionarlos, es decir, cambiar la clave de acceso al almacén, ver la informacién de
cada entrada, borrar una entrada, renombrarla o copiarla, y en el caso de claves secretas o privadas, es posible
también, cambiar la password de acceso a la misma.

Para ello, acceder al menu: “Tools > Keystore manager” y seleccionar la opcién deseada en funcion del
formato del almacén.

& xeyTool IUI

File Wiew Innls|ﬂelp
5 JkS keystore .

& ‘ﬁ keystore manager>|
e JCEKS keystore ..

S
6%,
B OB # FKCS12 keystore .
o,
oy

Tt BkS keystore . =
[ welcome UBER keystare . LS
9 [ Create :
DI Keystore Systerm-level root CA cerdificate store .

Se puede acceder también mediante el botén de la barra de herramientas:

Se mostrara un cuadro de didlogo para seleccionar el almacén:

& KeyTool 1UI - select x|
Buscaren: ‘lj PruebaskeyTool ‘V‘ E
D EuroHelpks jce

Mombre de archivo: |EuroHeIpKS.jce |

Archivos de fipo: |.JCEKS keystores (jce) |v|

| selact || Cancelar |

Como en este caso se puede modificar el contenido del almacén, la aplicacion pide la clave de acceso al
almacén:

KeyTool IUI - get password for I x|

Enter password: | |

| o || CANCEL |
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Si se introduce correctamente, se mostrara la siguiente ventana:

& KeyTool TUI - ICEKS keystore manager

Eusko
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|
Private Key (keypair) & Trusted Certificate Entries:

Alias Entry | Walid Date 7 | SelfSigned * | Trusted CA 7 | Key Size | Cert Type | Cert Sig. Algo. Modified Date
hbwacert - - 1023 hits  [X.604 SHATwithRSA 16-jul-2008
eurohelpeert ¥ v - 1024 hits [X.604 MDSwithR 54 15-jul-2008
eurohelpclave? &= o Vi - 2048 hits  |X.604 SHATwithRSA 15-jul-2008
werisigneert Vi v Vi 2048 hits [X.509 SHATwithRSA 16-jul-2008

Secret Key (shared key) Entries:
Alias Entry Modified Date
eurohelpclaved &= 15-jul-2008

En cada entrada, pinchando con el botdn derecho del ratdén, se mostrara un menu contextual, distinto si la

Gestion de los certificados de un almacén

entrada es un certificado o una clave.

El menud contextual que aparece al pinchar sobre un certificado es el siguiente:

Private Key (keypair) & Trusted Certificate Entries:

Alias

Entry

Walid Date 7

hbwacert

=

i

eurohelpce
eurohelpcla
werisigncert

Wiew ceificate .

Delete trusted cedificate entry ..

Fename trusted cedificate alias .

Copy trusted cedificate entry ...

Permite:

e Ver certificado. (View certificate ...). Tal como se ha explicado en el punto 4.2.1

e Borrar la entrada seleccionada (Delete trusted certificate entry ...). Pedira confirmacion.
e Cambiar el nombre del alias del certificado.
]

Crear una copia del certificado. Pedira el nuevo alias para asignarselo a la copia.
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5.2 Gestion de las claves (privadas o secretas) de un almacén

El menu contextual que aparece al pinchar sobre una clave es el siguiente:

g KeyTool IUI - JICEKS keystore manager

Private Key (keypair) & Trusted Certificate Entries:

Sociedad Informatica del Gobierno Vasco

Alias Entry | Yalid Date ? | Self-Signed
bhvacert v 5
eurhelpcert_copy g o
eurohelpcert v

eurohelpclave

verisigncert

Permite:

View cerificates chain ...

Delete private key entry ...
Rename private key alias ..
Copy private key entry ..

Change private key's passward .

e Ver la informacion del par de claves publica y privada (View certificates chain ...). o de la clave

secreta (View infos ...), en funcion del tipo de clave seleccionada.
e Borrar la entrada seleccionada (Delete private/secret key entry ...). Pedira confirmacion.
e Cambiar el nombre del alias de la clave (Rename private/secret key alias ...).
e Crear una copia de la clave (Copy private/secret key entry ...). Pedira el nuevo alias para

asignarselo a la copia.

e Cambiar la password de acceso a la clave (Change private/secret key’s password ...).

Las claves en un almacén, ya sean privadas o secretas, estan protegidas con una password de acceso.

Para hacer cualquiera de las acciones anteriores (excepto ver informacion) se pedira la password con un cuadro
de didlogo como el siguiente:

KeyTool IUI - get password for ﬂ

Enter password: |

018

CAMCEL
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5.3 Gestion del almacén por defecto de la implementacién Java

La aplicacion KeyTool IUl, al igual que en la opcion de visualizacion, permite gestionar el almacén de
certificados que viene por defecto con el JRE de Java (cacerts). Para ello acceder al menu: “Tools - Keystore
manager - System-level root CA certificate store ...”

& KeyTool IUI

File Wiew Il:u:uls|ﬂe|p

& & Keystnnla_m’anagerr oy JKS keystare .
S " | & JCEKS keystore . _
=5 . PKCS12 keystare ..
— &%, BKS keystore .. =
| g‘;‘e'“:me %, UBER keystare ... L
reate
El Keystare System-level rn:u:ult Clﬂ.x.ielrtlﬂcate stare .

Se solicitara la password de acceso al almacén, que si no se ha cambiado, deberia ser: “changeit”. A
continuacion se mostrara una ventana con los certificados en los que se confia. Se podra gestionar dichos
certificados de la forma descrita en el apartado 5.1.

5.4 Cambio de la password de acceso al almacén.

Los almacenes de certificados y claves pueden estar protegidos por password de acceso. La aplicacion
KeyTool Ul permite también cambiar dicha password.

Para ello, en la ventana de gestién del almacén, seleccionar el icono: @ . (Ver la siguiente imagen)

_,}j KeyTool IUI - ICEKS keystore manager

@@

e ME3| Chanoe this keystore's password rES:

Alias Entry | Yalid Date ? | Sel:-Si
bhwacert v <
B L ey [p] [*] i

Se mostrara un cuadro de diadlogo solicitando la nueva password y la confirmacioén, para detectar posibles
equivocaciones al escribir.

KeyTool IUI - create password x|

Enter new passward: | |

Canfirrm nesw password: | |

(]38 CAMCEL
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En el presente capitulo se describen el resto de funcionalidades que implementa la aplicacién KeyTool

A cada una de las tareas que se describira se podra acceder tanto desde el menu izquierdo de la
aplicacion como desde la barra de mend, a través de la opcién: “View > Select task”.

& KeyTool 1UI o =]
Eile f| wiew | Tools Help
Selecttask ¥ Welcome to Keytool LI | — Barra de mend \‘}
File M Create » -
= Archive »
("o |- kevtaor i | 190 dl |1
[ Welcor] Verity »
¢ [CJCreate | Encrypt 3
[ key Decrypt »
¥ I? KDE\” Import y
Export 3
b\
RGED
GyEC
@ [ Private key, with vers. #3 cert.
R
REED
)=
D Secret key
o= 3 Archive files
o= [ Sign file with private key
o= [ Verify signed file
o= [ Encrypt file with keystore's entry
o= 3 Decrypt file with keystore's entry
o= 3 Impaort
o [ Expart
.\ r,
Menii Izquierdo

Unicamente se describira el acceso a cada tarea a través del menu izquierdo, por considerar que el
acceso desde la barra de menu se desprende del anterior.

Por otro lado, para todas las tareas cabe sefalar que, de los formularios que se presentan, los campos
con asterisco son obligatorios.

.. . . - m OK
Inicialmente, el botén para llevar a cabo la tarea correspondiente aparece deshabilitado Q- .

Se habilitara cuando todos los campos obligatorios hayan sido rellenados _ -

6.1

Creacion de un almacén de certificados
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Para crear un nuevo almacén de certificados vacio, ir a la opcion “Create - Keystore” del menu izquierdo
de la aplicacion.

7 [ Kewtoal 1L
|j| Welcome
9 [ Create

[ keystore]

En la parte derecha de la aplicacion se mostrara el siguiente formulario:

Create keystore without any entries

Target:
o JKS
) JCEKS
# Keystore file: - [ ) PKCE12
) BkS
) UBER

keystare password: @ |

Seleccionar el formato para el almacén entre los disponibles en la aplicacion: JKS, JCEKS, PKCS12, BKS
y UBER (ver mas informacion de los formatos aceptados por la aplicacion en el punto titulado: “Formatos
admitidos para certificados y claves” de este mismo manual).

Pinchar en el icono: y en la ventana que aparece, seleccionar la ubicacion preferida para el fichero
del almacén e indicar un nombre.
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& KeyTool IUI - Save file x|

Buscar en; ‘ﬁ FruehaskeyTool |v‘ E

D EuraHelpks jce

Mombre de archivo: |myKeyStnre.jce |

Archivos de tipo: ‘JCEKS ticel |v‘

Save file H Cancelar ‘

Puede indicarse también una password de acceso para el almacén de certificados y claves. Se
recomienda que se indique una.

Pulsar el boton “OK” para terminar el proceso. Debera aparecer un mensaje avisando de que la operacion
se ha realizado con éxito.

KeyTool IUI - information x|

@ Successiully created an empty keystore of type JGEKS.

File location:
CiaDocuments and SettingsiadmimEscritorictPruebaskeyToohmylkeyStore joe

6.2 Creacion de una clave secreta y asignaciéon a un almacén

En esta tarea se creara una nueva clave secreta, de uso en el cifrado simétrico, y se incluira en un
almacén previamente definido.

Para crear una nueva clave secreta ir a la opcion “Create > Keystore’s entry = Secret key” del menu
izquierdo de la aplicacion.
9 [ Create
|j| Feystore

9 [ Keystare's entry
o= [ Private key, with ver
o= [ Private key, with ver

[ [Becret key
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En la parte derecha de la aplicacion se mostrara el siguiente formulario:

Create secret key (shared key) entry

Elkart:
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Source:

#* Keystore file: =

Target:

New Entry - Secret Key:

#* Secret key algorithm:

Kevstore password: @

Elowiish

o JCEKS
) BKS
i LUBER

Seleccionar el formato para el almacén entre los disponibles: JCEKS, BKS y UBER. No todos los
formatos de almacén disponibles en la aplicacién permiten incluir en ellos claves secretas, asi que Unicamente

se puede seleccionar entre los formatos que si lo permiten.

oy
Pinchar en el icono y en la ventana que aparece, seleccionar el fichero del almacén.

Elegir entre los disponibles un algoritmo de creacién de la clave (Secret key algorithm). Pulsar OK para

terminar el proceso.

Si el almacén tuviera password de acceso, y no se ha indicado una en el campo “Keystore password”

aparecera el siguiente mensaje:
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KeyTool IUI - warning x|

A Got 10 Exception, file lacation:
CADocuments and SettingstadmimEscritarioPruehaskeyToolmykeyStore joe

... Tampered keystare file, or incorrect JCEKS kewstore passward!

En caso contrario, aparecera una ventana con el contenido del almacén y en la parte inferior un formulario
para rellenar:

Enter new secret key entre's alias: “

Enter new: passward: [

Confirm new: passward: [

| ok || CANGEL |

En él, senalar un nombre para la clave secreta y una password de acceso. Todos los campos del
formulario son obligatorios (a pesar de no estar indicado con el asterisco), salvo para el caso de almacenes en
formato PKCS12.

Pulsar OK para terminar la operaciéon o CANCEL para cancelar.
6.3 Creacion de una clave privada y asignacion a un almacén

En esta tarea se creara una clave privada, de uso en el cifrado asimétrico, y se incluird en un almacén
previamente definido.

Para crear un nuevo par ir a la opcion “Create > Keystore’s entry” del menu izquierdo de la aplicacion.
Desplegar el nodo en funcién de si se desea crear una par de claves con versién 1 del estandar X.509 (Private
key, with vers. #1 cert.) o versiéon 3 (Private key, with vers. #1 cert.). Dentro de dicho nodo, seleccionar el tipo de
algoritmo deseado para generar la clave: DSA (Digital Signature Algorithm), RSA (Rivest, Shamir, Adleman) y
EC (Elliptic Curve).

o [ Create

B keystore

? [ Keystare's entry
9 [ Private key, with vers. #1 cert.

[ Dsa
[y rsa
[ EC
¢ |j|F'rivate ke, with wers. #£3 cert|
[y Dsa
[y rsa
[ EC

21/37



= . .
Eusko en Informatika Elkart
Ie Sociedad Informéatica del Gobierno Vasco

En la parte derecha de la aplicacion se mostrara el siguiente formulario:
Create RSA private key entry, with vers. #1 cert

Source: | = |
) JKS
0 JCEKS
* Keystore file: 9 [ (0 PKECE12
) BKS
) UBER

keystare password: @

Target:
Private Key:
#* Key size dhits): 2048 |- B
# Signature algorithm: SHATwiIthRSA -

# validity (days): F & [109s

Cert. - X.500 Distinguished Name:

#* Commoaon (or domain) name: W [

Qrganizational unit: 7 l

Organizatian: o [

City or lacality: 7] [

State ar province: W l
* Z-letter country code: ¥ [ |us (united States) = B
-

IO o«

Seleccionar el formato para el almacén entre los disponibles: JKS, JCEKS, PKCS12, BKS y UBER.

Rellenar los campos obligatorios del formulario, de forma similar a como se ha descrito en el punto
anterior. Rellenar los campos opcionales que se desee.

Respecto a las extensiones, campos opcionales al final del formulario (ver imagen siguiente), en la ayuda
de la aplicacidon se muestra qué opciones activar en la creacion del par de claves para diferentes casos de uso.
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Cert. Extension - KeylUsage:

- encipherOnly:

ENABLED?
- CRITICAL?
- digitalSignature:
- nonRepudiation: [ []
- kevEnciphermen:
- dataEnciphermefit: [#7]
- keyAgreement =]
- keyCertSion: ™=
- tRLSian: |

[
=

- decipherOnly:
Cert. Extension - ExtKeylUsage:

ENABLED?
- CRITICAL?
- serverAuth:
- clientAuth:
- codeSigning
- emailProtection:
- ipsecEndSystem:
- ipsecTunnel:
-ipseclser:
- timeStamping:
- DCEPSigning:

- Microsoft Enroliment Infrastructure: smartcardlog
- Microsoft Crypto 2.0 server gated crypta

- Microsoft Crypta 2.0: serialized

- Microsoft Crypta 2.0: EFS crypta

- Microsoft Crypta 2.0 EFS recovery
- Adobe: CDS PKI

- unknown key usage

Bl KeyTool IUI - User's Guide 0] x|
<
¥

EjJie

on;

) i { o 1 o o e o o T

Elkart,

Eusko en Informatika
Sociedad Informéatica del Gobierno Vasco

(0]

3 User's Guide
D Welcome to KeyToal 1]
[ About ..
¢ [ Tasks
9 [ Create
D Create empty keystan
D Create secret key ent
D Create DSA private ke
D Create RSA private ke

D Create DSA private ke

D Create RSA private ke
D Create EC private ke

o= [ Archive files

o= ] Signfile

o= [ Yerify signed file

o [ Encrypt file

o= ] Decryptfile

o= 9 Impart

o= ] Export

o= ] Supported farmats

[ Create EC private ke =

About "KeyUsage' Certificate Extension

d
4

Exemple of use:

Top lewvel CA:
critical,
keyCertSign,
cRL3ign.

230 wek server, 35L application zerver:

critical,

digitalSignature,

kevyEncipherment.

Chiect-signing SMI,
critical,
digitalSignature.

People SMI-ewmployes encryption:
critical,

Chject-zigning partner, People SMI-=

[»

[«]

1| M I

[¥]
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Pulsar OK para crear la clave y comenzar el proceso de asignacion al almacén. Si el formulario se ha
rellenado correctamente, aparecera la ventana con el contenido del almacén y el mismo formulario que en el
punto anterior (claves secretas). Proceder de forma similar.

En este caso, si el almacén es de tipo PKCS12, no sera necesario rellenar la password de acceso a la
clave.

Problema conocido

Existe un problema reconocido por el autor de la aplicacion en la creacion de claves con algoritmo DSA,
version 1 o version 3. Para los almacenes de tipo: PKCS12, BKS y UBER, aunque aparezca como algoritmo de
firma (Signature algorithm) SHA1withDSA, la clave se estara almacenando como DSA.

6.4 Creacion del jar de un directorio

En esta tarea se creara un fichero .jar con el contenido de un directorio dado.

Para crear un jar con el contenido de un directorio ir a la opcién “Archive files = Directory” del menu
izquierdo de la aplicacion.

7 [ Keytoal U]
D Welzome

o= ] Create
o ] Archive files

B Directory

En la parte derecha de la aplicacion se mostrara el siguiente formulario:
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Archive directory in JAR format

Source:
* Directory; = [
Target:
# Unsigned JAR file; [ < JAR

N ) ok

Seleccionar el directorio cuyo contenido se quiere empaquetar en un jar.
Seleccionar el directorio y el nombre del fichero .jar que se creara.

Pulsar OK para terminar la operacion.

6.5 Firma digital de documentos

Se describira en este punto la funcionalidad que ofrece la aplicacién KeyTool IUI para firmar documentos.

Permite firma en modo ‘detached’ cualquier documento, o en modo ‘embedded’ ficheros XML o jar. La
diferencia entre ambos métodos de cifrado es que en modo ‘detached’ el fichero de firma generado no incluye
los datos firmados, sin embargo en el modo ‘embedded’ si.

Para firmar un documento, ir a la opcion “Sign file with private key” del menu izquierdo de la aplicacion y
seleccionar el método de firma deseado.
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&[] Create

o= [ Archive files

¢ C|5ign file with private key|
9 [ Detached signature

[ cms
[y other

- ] Embedded signature
RECE
[ 2R

O= 1 Wiarife cirned fila

El proceso de firma en todos los casos es el mismo:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los campos

obligatorios (marcados con asterisco) y los opcionales que se desee. Pulsar OK para continuar
con el proceso.

2. Apareceréa una ventana mostrando el contenido del almacén seleccionado. Se indicaran las

claves que pueden ser utilizadas para firmar con el simbolo __« | Seleccionar entre todas
ellas la clave con la que se desea firmar:

i KeyTool IUI - Sign file with private key and save as other detached signature file : ll
Private Key (keypair) & Trusted Certificate Entries:
Candidate Alias Entry|Walicd Date | Selt-Signed ?|Trusted C.A 7| Key Size |Cert Type| Cert Sig. Algo. | Maodified Date
- hbvacert - - 1023 hits [X.409 SHATwithRSA  |16-jul-2008
- eurhelpcert_copy v 1024 bits |} 509 Id D Swith RS A 16-jul-2008
B eyrohelpcert N 1024 hits  [X.509 WD SwithRSA 15-jul-2008
¥ eurohelpclave? s T < = 2048 hits  [$.509 SHATwithESA  |16-jul-2008
- varisigneert v Vi v 2048 bits  [X.509 SHATwithRSA  |16-jul-2008
Secret Key (shared key) Entries:
Candidate 7 | Alias | Entry | Modified Date
- |eurohelpclaved | &= |15 ju-z008
Selected entny's alias: [eurohelpclaveE
Enter respective password: [uuu
CANCEL

3. En el formulario inferior indicar la password de acceso de la clave seleccionada.

Al pulsar OK aparecera un mensaje de confirmacion indicando que se ha realizado con éxito la operacion.

6.6 Validacion de la firma digital de un documento
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Se describira en este punto la funcionalidad que ofrece la aplicacién KeyTool IUl para validar documentos
firmados utilizando los métodos descritos en el punto anterior.

Para validar la firma de un documento, ir a la opcion “Verify signed file” del menu izquierdo de la
aplicacion y seleccionar el método con el que se sabe que estéa firmado el documento.

L L N VYA RV Ty

o [ Merify signed file

7 [ Detached signature
[ cms
[ other

9 [C1 Embedded signature
RE(E
[ Jar

S T M mmin wnd Film ikl Lemnimdmwm b mmde

El proceso de validacién es muy parecido en todos los casos:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los campos
obligatorios (marcados con asterisco) y los opcionales que se desee. Pulsar OK para continuar
con el proceso.

2. En el modo ‘Other detached signature’ aparecerd una ventana mostrando el contenido del
almacén elegido. Se indicaran los certificados que pueden ser utilizados para validar la firma con

el simbolo —_¥"___. Seleccionar el de la persona o entidad que firmé el documento.
;3, KeyTool IUI - Sign file with private key and save as other detached signature file ll
Private Key (keypair) & Trusted Certificate Entries:
Candidate Alias Entry|Walicd Date | Selt-Signed ?|Trusted C.A 7| Key Size |Cert Type| Cert Sig. Algo. | Maodified Date
- hbvacert - - 1023 hits [X.409 SHATwithRSA  |16-jul-2008
- eurhelpcert_copy v 1024 bits |} 509 Id D Swith RS A 16-jul-2008
B eyrohelpcert N 1024 hits  [X.509 WD SwithRSA 15-jul-2008
¥ eurohelpclave? s T < = 2048 hits  [$.509 SHATwithESA  |16-jul-2008
- varisigneert v Vi v 2048 bits  [X.509 SHATwithRSA  |16-jul-2008
Secret Key (shared key) Entries:
Candidate 7 | Alias | Entry | Modified Date
- |eurohelpclaved | &= |15 ju-z008
Selected entny's alias: [eurohelpclaveE
Enter respective password: [uuu
CANCEL

En el formulario inferior indicar la password de acceso de la clave seleccionada.

3. En el modo ‘JAR embedded signature’ se deberan seleccionar los puntos que se quieren validar
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(apartado ‘target’ del formulario).
Target:

Entries' size: [¥]
Entries' date: [ ]
Cers type: v
Algos name: [v]
Subject DM [ ]

4. Al pulsar OK aparecera un mensaje de confirmacién indicando que se ha realizado con éxito la
operacion.

En el modo ‘JAR embedded signature’ el mensaje de confirmacion es el devuelto por la aplicacién
jarsigner al invocarla con la opcién —verify.

6.7 Cifrado de documentos utilizando la entrada de un almacén

Se describira en este punto la funcionalidad que ofrece la aplicacién KeyTool IUl para cifrar documentos
utilizando una entrada previamente almacenada en un almacén de certificados y claves.

Para cifrar documentos, ir a la opcion “Encrypt file with keystore’s entry” y seleccionar la opcién deseada
en base al tipo de cifrado requerido.
L METIY ST e

T |j|En|:rg.fptﬂIe with keystore's entr'g.f|
E‘| Llse secret key
B Uze RSA trusted cerificate
E‘| lse RSA private key

o= [ Decrypt file with keystore's entry

= Secret key: Utilizado en cifrado simétrico.

= RSA trusted certificate: Utilizado para cifrar documentos con la clave publica de una persona. De este
modo nos aseguramos que Unicamente dicha persona pueda leer el mensaje.

= RSA private key: Utilizado para cifrar un documento con nuestra clave privada. De este modo nos

aseguramos que Unicamente podran leer el mensaje aquellas personas que tengan nuestra clave
publica.

El proceso de cifrado es similar en todos los casos:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los campos
obligatorios (marcados con asterisco).

2. En cifrado con clave secreta el algoritmo de cifrado vendra definido por el algoritmo que se indicé

al crear dicha clave, en los otros dos casos se puede seleccionar de una lista dada (campo ‘RSA
Encryption Algorithm’).
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3. Pulsar OK para continuar con el proceso.

4. Aparecera una ventana mostrando el contenido del almacén seleccionado. Se indicaran las

entradas que pueden ser utilizadas para cifrar el documento con el simbolo JRRT )
Seleccionar entre todas ellas la clave o el certificado con el que se desea cifrar:

& KeyTool IUI - Encrypt data file with secret key, save result as file 5[
Private Key (keypair) & Trusted Certificate Entries:
Candidate Alias Entry|Valid Date ?|SeltSigned ?(Trusted C.A 7| Key Size |Cert Type| Cer. Sig. Algo. | Modified Date
- hbvacert - - 1023 hits X409 SHATwithRSA  [16-jul-2008
ehnocifrado &= Vi 2048 hits %509 SHATwithRSA  [17-jul-2008
eurhelpcert_copy Vi 1024 hits  |*.509 MO &withREA  [16-jul-2008
eurahelpeert J 1024 hits  |*(509 MDawithREA  [15-jul-2008
eurohelpcertl Vi Vi 2048 hits  |*5049 SHATwithRSA  [17-jul-2008
eurchelpclavel o < v 2048 hits  }.509 SHATwithRSA  [16-jul-2008
eurchelpclaved o Vi Vi - 2048 hits X509 SHATwithRSA  [17-jul-2008
verisigncert Vi Vi Vi 2048 hits  |¥.509 SHATwithRSA  [16-jul-2008
Secret Key (shared key) Entries:
Candidate ? Alias Entry hodified Date
i eurohelpclave3 o 148-jul-2008
Selected secret key entry's alias: [eurohelpclavea
Enter respective password: quu|
| ok | | GANGEL |

5. En el formulario inferior indicar la password de acceso de la clave seleccionada.
Al pulsar OK aparecera un mensaje de confirmacion indicando que se ha realizado con éxito la operacion.
Limitaciones

Para el cifrado con clave secreta, los algoritmos de cifrado Hmac (md5, sha1, sha256, ...) no funcionan
correctamente.

Para los cifrados RSA, el tamario de los datos a cifrar no deberia ser mayor (en bytes) de:
(<tamafio de la clave de cifrado>/ 8) — 11
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6.8 Descifrado de documentos utilizando una clave de un almacén

Se describira en este punto la funcionalidad que ofrece la aplicacién KeyTool IUl para descifrar
documentos utilizando una clave (privada o secreta) existente en un almacén.

Para descifrar documentos, ir a la opcidn “Decrypt file with keystore’s entry” y seleccionar la opcién
deseada en base al tipo de cifrado del documento.
o= |_T] Encrypt e with Keystare's entry

? |j|DecnfptﬂIe with keystore's entrﬂ

D lze secret key
D Llze RESA private key

S e I

El proceso es similar en ambos casos:

1.

5.

6.

En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los campos
obligatorios (marcados con asterisco).

En cifrado con clave privada RSA habra que indicar el algoritmo con el que esta cifrado el
documento, en el caso de clave secreta no es necesario.

Pulsar OK para continuar con el proceso.

Aparecera una ventana mostrando el contenido del almacén seleccionado. Se indicaran las

entradas que pueden ser utilizadas para descifrar el documento con el simbolo JERY S |

Seleccionar entre todas ellas la clave con la que se desea descifrar.
En el formulario inferior indicar la password de acceso de la clave seleccionada.

Pulsar OK para terminar la operacion.

En este caso, si todo ha ido correctamente no aparecera mensaje de confirmacién, pero si se indicara un
mensaje de error en el caso de que haya algun problema.

6.9 Importacion de claves y certificados a un almacén

Se describira en este punto la funcionalidad que ofrece la aplicacién KeyTool IUl para importar claves

secretas, claves privadas y certificados a un almacén previamente definido.

Para importar documentos, ir a la opcién “Import > Keystore’s entry” y seleccionar la opcién deseada en
base al tipo de fichero que deseamos importar.
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; s e L e e iy
¢ [ Impart

7 [CKevstare's entry

|j| Secret key

9 [ Private key
[y DER file forrmat
[y PEM file format
D From other keystore

9 [ Trusted certificate
E| Fegular cerificate
[ Root CA cetificate

E| Private key's cert. from CA cert. reply

= Secret key: Para importar claves secretas.

Se debera conocer ademas de la password de acceso a la clave, el algoritmo de cifrado para el que
se creo dicha clave. La aplicaciéon no puede comprobar si el algoritmo introducido es correcto o no,
asi que debe ser el usuario el que se asegure de ello.

= Private key: Para importar claves privadas.

En este caso, habra que seleccionar el fichero desde el que importar la clave privada y el fichero
desde el que importar el certificado (o cadena de certificados) con la clave publica.

Para importar una clave desde un fichero en formato DER, se debera conocer el algoritmo de cifrado
para el que se cred dicha clave.

= Trusted certificate (Regular certificate): Para importar certificados de confianza.
Se seleccionara el formato del fichero a importar entre los tres posibles: DER, PKCS#7 y PEM.

La aplicacion permite seleccionar si se comprobara que la CA del certificado sea una de las incluidas
en el almacén de autoridades certificadoras de raiz (Root CA certs store).

El procedimiento para importar certificados de confianza de Autoridades Certificadoras raiz (Root CA
certificate), se explicara mas adelante.

El proceso para la importacion de claves y certificados es similar en todos los casos:
1. Rellenar los campos del formulario que se mostrara en la parte derecha de la aplicacion.
2. Pulsar OK para continuar con el proceso.

3. Sise ha seleccionado ‘importar desde otro almacén’ (From other keystore), aparecera una
ventana con el contenido del almacén origen. Se indicaran las entradas que pueden ser utilizadas

para importar con el simbolo ¥ | Seleccionar entre todas ellas la clave que se desea
importar e indicar su password de acceso en el formulario inferior. Si se ha seleccionado
cualquier otra opcion se pasara directamente al punto 4.

4. Al pulsar OK para continuar con el proceso, aparecera una ventana mostrando el contenido del
almacén seleccionado como destino.

5. Rellenar los campos que aparecen en el formulario inferior, indicando el alias para la clave
importada y la password de acceso a la misma.

6. Pulsar OK para continuar con el proceso. Aparecera un cuadro de dialogo indicando que se ha
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completado con éxito la operacion y preguntando si se desea ver el contenido del almaceén.
KeyTool IUI - confirm x|

L ] Successfully imparted private key and certs chain files as private key entry.
Mew private key entry located in keystore:
CiDocuments and SettingsiadmimEscritorioiPruehaskeyToolhmykeyStore joe

View keystore?

Ok || CANCEL |

7. Sise pulsa OK, aparecera de nuevo la ventana con el contenido del almacén, donde podra
comprobarse que se ha importado la clave con éxito.

6.9.1. Importacion al almacén de Autoridades Certificadoras Raiz: cacerts

Como se ha comentado en puntos anteriores, la aplicacién KeyTool IUl permite la gestion del almacén de
entidades certificadoras (CAs) de confianza que viene por defecto en la implementacion Java (cacerts). Asi
pues, con respecto a la importacion de certificados, la aplicacion permite importar los certificados de dichas
entidades, para confiar automaticamente en cualquier certificado autorizado por las mismas.

Para ello, ir a la opcion “Import > Keystore’s entry > Root CA certificate”.

Ll AL I WAL IR L e o eIy

[ Impart
9 [ Keystare's entry
E| Secret key

o= [ Private key

7 [ Trusted cedificate
|j| Regular cedificate
[ Root CA certificate

|j| Private key's cert. from CA cert. reply

El proceso es similar al descrito en el punto anterior, la Unica diferencia es que en el campo del almacén
viene seleccionado por defecto el definido por la implementacién Java y no es posible seleccionarlo.

6.9.2. Importacion desde el fichero de respuesta de una CA

Cuando una entidad desea que una CA autorice un certificado suyo, envia una solicitud a una CA raiz,
mediante un mensaje CSR (Certificate Signing Request) firmado por su clave privada. La entidad raiz le
responde con un mensaje que utiliza la sintaxis definida en PKCS#7. La aplicacion KeyTool Ul permite importar
desde el fichero de respuesta de la CA raiz.

Para ello, ir a la opcion “Import - Private key’s cert. from CA cert. reply”.
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7 [ Impart
9 [ Kevstare's entry
D Secret key
o= ] Private key
o= [ Trusted cedificate

D |F'rivate key's cert. from CA cert. reply
= Evninrt

Los pasos a seguir son los siguientes:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los siguientes
datos:

= CA cert. reply file: con el fichero de respuesta a la solicitud CSR.

= Keystore file: con el almacén que contiene la clave privada con la que se firmé la solicitud
CSR.

2. Al pulsar OK para continuar con el proceso, aparecera una ventana con el contenido del almacén
origen. Se indicaran las entradas que pueden ser utilizadas para la importacion, con el simbolo
& | Seleccionar entre todas ellas la clave con la que se firmé la solicitud.

3. Completar el formulario inferior.

4. Pulsar OK para continuar con el proceso.

Aparecera un mensaje indicando que se ha realizado con éxito la operacion y preguntando si se desea
ver el almacén con los cambios efectuados.

KeyTool IUI - confirm x|

- Successfully imported private key and certs chain files as private key entry.
]
Mew private key entry located in keystore:

ChADacuments and SettingstadminEscritoriciPruehaskeyToolmykeyStare joe

Wiew keystore?

0K || CANCEL |

6.10 Exportacion de claves y certificados a fichero

Se describira en este punto la funcionalidad que ofrece la aplicacién KeyTool IUl para exportar claves y
certificados que estén incluidos en un almacén a un fichero.

Para importar documentos, ir a la opcién “Export - Keystore’s entry” y seleccionar la opcién deseada en
base al tipo de clave o certificado que vamos a exportar.
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= L
9 [ Export

o [ |Keystare's entry

E‘] Secret key
D Frivate key
D Trusted cerificate

9 [ Private key's first cerificate in chain
D As cedificate signing request file
D As simple certificate file

= Secret key: Para exportar claves secretas.
= Private key: Para exportar claves privadas.

Se exportara tanto la clave privada como la cadena de certificados de la clave publica, es decir, el

certificado con la clave publica en si y los certificados de las entidades que validan el par clave
privada-clave publica, si los hubiera.

= Trusted certificate (Regular certificate): Para exportar certificados de confianza.

El proceso para la exportacion de claves y certificados es similar en los tres casos:

1. Rellenar los campos del formulario que se mostrara en la parte derecha de la aplicacion.
Seleccionar el formato del fichero que contendra la clave y/o certificados. Los formatos que
admite la aplicacion para los ficheros exportados son:

Formato Exte_n Sl
del Fichero
DER .der Fichero binario
PEM .pem Fichero ascii
PKCS#7 .p7b Fichero binario

2. Pulsar OK para continuar con el proceso.

3. Apareceréa una ventana con el contenido del almacén donde se encuentra la clave o certificado a
exportar. Se indicaran las entradas que pueden ser utilizadas para importar con el simbolo

& | Seleccionar entre todas ellas la que se desea importar e indicar la password de
acceso en el formulario inferior para el caso de las claves.

4. Aparecera un cuadro de dialogo indicando que se ha completado con éxito la operacion y
preguntando si se desea ver los datos de la clave o certificado.
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KeyTool IUI - confirm x|

Trusted ertificate successiully exported.
. cetificate location:
CoRrogramasikil 2 4 staikil 2 4 staithawtecert.cer

Wiould you like to view the result?

] || CAMCEL |

ﬂ KeyTool IUI - view X.509 certificates chain i 5[

Mumber of cedificates in cedificates chain=1

---- BEGIM ¥.509 CERTIFICATE #1511 -
Cwyner=
EMAILADDRESS=personal-freemail@thawte. com, CHN=Thawte Personal Freemail CA,
lssuer=
EMAILADDRESS=personal-freemail@thawte.com, CH=Thawte Personal Freemail CA,
Wersion=3
Serial Mumber=0
Walid From=Ilunes 1 de enero de 1996 1:00
Walid Until=viernes 1 de enero de 2021 0:549
Signature Algorithm=MD SwithR 5S4
Fingerprints=
MD4E:  TEF4:CIBRICOC 35 CA3ECETREF IC:ANICDY
SHAT, 20:89:00:B6:30:95:57:28:14:.02:01:36:22:.08:C6. 87 A4 EB.00:85
Key lLsage= none
Extended Key Usage= none
---- EMD %509 CERTIFICATE #1751 -

1] Il | IC

CLOSE

Exportacion del certificado con la clave publica

Lo que se ha nombrado a lo largo de todo el manual como clave privada, es como ya se ha dicho, la

5. Sise pulsa OK, aparecera un cuadro de didlogo donde podran comprobarse los datos de la clave
o certificado exportado.

suma de: la clave privada, el certificado con la clave publica y los certificados de las entidades que validan la

clave. Este punto describe la funcionalidad que ofrece la aplicacion KeyTool IUl para obtener el primer

certificado de la cadena, es decir, el certificado con la clave publica asociada a la clave privada.

Para ello, ir a la opcion “Export = Private key’s first certificate in chain” y seleccionar la opcién deseada:
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7 [ Expart

9 [ Keystare's entry
E| Secret key
E| Frivate key
E| Trusted cedificate

T |j|F*rivate key's first cedificate in chain|
D Az cedificate signing request file
|_j Az simple cerificate file

= As certificate signing request file: Para crear el mensaje CSR (Certificate Signing Request)
comentado en el punto 6.9.2.

= As simple certificate file: Para exportar el certificado con la clave publica asociada a una clave
privada.

El proceso es similar al descrito en el punto anterior, por o que no se describira.
7  Acceso ala ayuda de la aplicacion

El autor de la aplicacion KeyTool IUl ofrece una ayuda muy simple, pero en la que muestra informacion
relevante en muchos casos, como son limitaciones a las funcionalidades que se ofrecen (han sido descritas
todas en este manual) y casos de uso en la creacion de certificados. Por ello, se considera importante el
conocer como se accede a la ayuda de la aplicacion.

Para acceder a la ayuda de la aplicacion, ir a la opcion “Help = Help topics = User’s Guide ...".

& xeyTool IUI

File Yiew Tools ﬂelpl

e & & Help topics #| (2] Users Guide .
- =
~

3 About b s Help on active window's task

R ean

|

Aparecera una ventana con dos paneles, a la izquierda los puntos de la ayuda y a la derecha el panel
donde se muestra la explicacién de cada punto:

Se puede acceder también mediante el boton de la barra de herramientas:
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[ User's Guide
[} etcome s Keffot U]
[ about ..
9 =1 Tasks
o ] Create
o= ] Archive files
o~ ] Sign file
o= [ Verify signed file
o= 3 Encrypt file
o= 3 Decrypt file
o= ] Import
o 3 Export
o= ] Supported farmats
D Support

T

+

Welcome to KeyTool TUI

Copyright @ 2001-2008 YellowCat Project. All Rights Reserved. All brands and their products are trademarks
| of their respective holders.

Conditions of use

License Agreement

Please read the following terms and conditions before using this software. This software is the confidential
and proprietary information of YellowCat Project. Your use of this software indicates your acceptance of this
license agreement and warranty.

‘| License

[»

[l
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